Bloque Il. Herramientas

Capitulo 7. Uso de un entorno integrado de desarrollo de
programas

e Proceso de desarrollo de programas

« El compilador y la ejecucion

« Uso del entorno de desarrollo de programas bluej

 La depuracion

« Generacion de documentos

 Empaquetamiento del programa
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Proceso de desarrollo del programa

Proceso a seqguir:

Editar — Compilar — Enlazar — Ejecutar/Depurar

-

Solo si usamos el proceso de compilacion clasico

En Java usaremos la maquina virtual y no hacemos el proceso de
enlazar

Se pueden usar diversos editores de texto

e en UNIX utilizar el "gedit”, "nano” o "emacs”
- para invocar el “gedit”: gedit Nombre. java

e en Windows utilizar el emacs, el “bloc de notas’ o el "worapad"
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El compilador y la ejecucion

Utilizaremos el compilador Java SE JDK de Oracle

Para compilar desde la shell o intérprete de drdenes una clase
almacenada en un fichero llamado Nombre. java:
javac Nombre. java
La compilacion crea la clase ya compilada, en un fichero denominado
Nombre.class
Para ejecutar una clase llamada Nombre. class con la maquina virtual:
java Nombre
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Ejemplo

/>|<>I<
* Programa que pone un mensaje en la pantalla
*/

public class Hola {

/>|<>I<
* Este es el método principal
*/
public static void main(String[] args) {
// No hay declaraciones
System.out.println("Hola, Que tal estas?");

}
}
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Uso del entorno de desarrollo de
programas Bluej

Un entorno integrado de desarrollo de programas suele presentar las
siguientes caracteristicas:

e interfaz grafica con menus desplegables, comoda de usar

e editor de texto orientado al lenguaje

e compilacion desde el entorno

e salto automatico al lugar donde ocurre un error de compilacion
e depuracion de alto nivel desde el entorno

Algunos entornos para Java suelen incorporar tambien herramientas de
documentacion y de generacion de interfaces graficas (“programacion
visual”)
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Gestion de proyectos

Para programar utilizando Bluej debe crearse un " proyecto’ por
programa.

El proyecto es un directorio en el disco donde se guarda toda la
informacion que se va generando relacionada con el programa:

e codigo fuente

e clases compiladas
e documentacion

e etc.
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Creacion de un nuevo proyecto

Elegir Project=>New Project, y luego situarse en el directorio
deseado y darle al proyecto un nombre. Ej:

practical

Anadir una clase nueva al proyecto. Para ello, pulsar el boton
New class

e luego darle un nombre
o y elegir las opciones deseadas (Class, para una clase normal)

Para editar la clase, hacer “doble click” sobre ella
e borrar el cddigo predeterminado que no necesitemos
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Compilar y ejecutar el programa

Para compilar:
e desde el editor: boton Compile

e desde el proyecto: con el boton derecho hacer “click” sobre la clase y
elegir Compile

e |los errores de compilacion aparecen en la parte inferior de la pantalla
e la linea con error queda resaltada

Para ejecutar desde la ventana del proyecto
e con el botdn derecho hacer “click” sobre la clase
e elegir la ejecucion del método main
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Crear y usar objetos

Para crear un objeto de una clase, pulsar el boton derecho sobre ella y
elegir la opcion new

Para ver los atributos de un objeto pulsar el boton derecho sobre él y
elegir la opcion inspect

Para ejecutar un meétodo de un objeto pulsar el boton derecho sobre él
y elegir el método deseado

Si el programa se bloquea el ejecutarse, con el boton derecho pulsar
sobre la barra de la maquina virtual (parte inferior izquierda de la
ventana del proyecto) y elegir “reset machine”

Ejemplo: con la clase Piedra que se muestra a continuacion:
e crear con el raton un par de objetos
e ejecutar sus metodos
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Ejemplo: Simulacion de la caida de una
piedra

Representaremos la piedra

con un objeto Yy
Vy ______ \Y
Atributos: T |
e posicion (X,y) Y- Es | "V,
e velocidad (vx,vy) l
X X
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Situacion inicial y ecuaciones

Ecuaciones del movimiento, para

calcular nueva posicion y velocidad

transcurrido un intervalo ¢

Calculo usando

Variable | valores viejos de

las variables

+ .
X XTV. -1 o 2
4 Y + Vy - )
s

vx Vx
v, vV, — 8" [

Y (m)
Vy=15m/s [ ——— — 5 |V
|
100 "V,=20 m/s
______ 0

X (m)
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Diagrama de la clase

Piedra

El método que pone los valores -double posX, posY
iniciales es un constructor _double vx V;,

\-double g
+Piedra
(double x, double vy,

double vx, double vy)
+double posX()

Métodos observadores /Ierouble posY()

+void avanzaTiempo

/ (double t)
Modifica los atributos segun

las ecuaciones

uc www.istr.unican.es © Michael Gonzalez Harbour, 10/oct/17
UNIVERSIDAD
DE CANTABRIA

12



Codigo Java del ejemplo

/>|<>|<
* Esta clase simula la caida de una piedra
*/

public class Piedra

{

// atributos que definen el movimiento
private double posX, posY; // posicion, metros
private double velX, velY; // velocidad, m/s

// constante que define la gravedad
public final double g=9.8; // m/(seg*seq)
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Codigo Java del ejemplo (cont.)

/>|<>|<

* Constructor que pone las condiciones
* iniciales, copiandolas de los argumentos.
* Unidades: m y m/s
*/
public Piedra
(double posX, double posY,
double velX, double velY)

this.posX=posX;
this.posY=posY;
this.velX=velX;
this.velY=velY;
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Codigo Java del ejemplo (cont.)

/>I<>I<
* Retorna la posicién X (m)
*/

public double posX() {

} return posX;

/>I<>I<
* Retorna la posicién Y (m)
*/
public double posY() {
return posY;

}
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Codigo Java del ejemplo (cont.)

/>|<>|<

* Avanza el tiempo en la cantidad t (s)
*/

?ublic void avanzaTiempo(double t)
posX=posX+velX*t;
posY=posY+velY*t-g*t*t/2.0;

// velX no cambia
velY=velY-g*t;
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Uso de paquetes externos al proyecto,
con ficheros jar

Para poder usar una clase definida en un fichero con extension . jar:

e Afadir ese fichero directamente a las librerias java

fundamentos.jar

- Tools => Preferences

- Elegir la pestana “Libraries”

- Elegir la opcion “Add. ..” en “User Libraries”
- Pinchar en el fichero jar (fundamentos. jar)

- Pulsar Abrir -> Aceptar -> 0K

e Acordarse de importar las clases a usar en el programa:
- 1mport fundamentos.lLectura;
- 1mport fundamentos.*;
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Uso de paquetes externos al proyecto
con directorios que contienen clases

Cuando el paquete es un directorio con clases situar este directorio en
otro para los paquetes; por ejemplo, en el directorio java

java

fundamentos

otros paquetes

» Anadir el directorio donde estan los paquetes
(java en este caso) a la lista de librerias
- no anadir el paquete directamente (no poner java/fundamentos)
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Ejemplo de uso del paquete
fundamentos

Anadir a la clase Piedra un método que lee valores iniciales del teclado

import fundamentos.*;
public class Piedra {

/>|<>I<
* Lee de una ventana la posicion y velocidad
* 1niciales
*/
public void leeValoresIniciales() {
Lectura L = new Lectura ("Datos iniciales");
L.creaEntrada("posicion X (m)",posX);
L.creaEntrada("posici6on Y (m)",posY);

l.creaEntrada("velocidad X (m/s)",velX):
l.creaEntrada("velocidad Y (m/s)",velY):
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Ejemplo

’

L.espera¥YCierra()
posX=1.leeDouble("posicion X (
posY=1.leeDouble("posicion Y (
ve1X=l.leeDoubleg"velocidad X

velY=1l. leeDouble("velocidad Y
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La depuracion

Es el proceso de prueba del programa para localizar errores

La depuracion se puede realizar:

e manualmente: insertando instrucciones de salida (println) que
muestren el flujo de control del programa vy el valor de las variables

de interés
e mediante un depurador de alto nivel

El depurador de alto nivel permite:
e parar el programa en los puntos deseados (breakpoints)

e ejecutar paso a paso
e visualizar el contenido de las variables ( watches)

e visualizar llamadas a métodos y sus argumentos
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Depurador del Bluej

Es un depurador para P =e 5 )

. <% Blue): Debugger |ﬂ‘i]w
programas Java con interfaz ) (5 cope) e ] [omon |
grafica

Threads
Js [ Wmain (at breakpaint)

* Clase que contiene los datos df

Permite introducir puntos de || |z o s
ruptura (breakpoints)

e “click” en la columna a la 3 ——
izquierda del codigo e, @ e e dirntiemr P

public MedidaElectrica(double

(aparece un @) 8 e S —

thisz.intensidad=intensida
double intensidad = 1.0

all Sequence Static variables

private double woltaje: v
private double intensidad; 1
E

!

rivate double tiempo; 3

Instance variables

this.tiempo=tiempo;

También permite controlarla ||| - =
eJ eCUCIOn, y Vlsuallzar L e L A e Halt Step Step Into Continue Terminate

informacion en la ventana de
depuracion
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Depuracion:
Control de la ejecucion

La ventana de depuracion se abre poniendo un punto de ruptura y
ejecutando el programa o un metodo

El programa se detiene en un punto de ruptura

El depurador tiene botones para:

Ejecutar paso a paso (entrando
| en métodos)

Step

Ejecutar paso a paso (saltando
'I-}| por encima de métodos)

Step Into
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Depuracion: )
Control de la ejecucion (cont.)

DI

E CANT/

C

ABRIA

T

Continue

Continuar la ejecucion

Halt

Hacer una pausa en la ejecucion
Stop (util para lazos largos o
infinitos)

2 ¢

Terminate

Finalizar la ejecucion

www.istr.unican.es
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Depuracion:
Visualizar informacion

= (B 2 |1 Circuito
Class Edit Tools Options ra BlueJ: Debugger | = [ = = ]
Undo [Copy] [F’aste] [Find... Options

Threads
™ L Wmain (at breakpoint)

* Claae pntiene los datos df At ri b UtOS

*7 // o

public class MedidaElectrica L t t

‘ estatiCos
Static variables /

MedidaElectrica. <init>

Secuencias de
llamadas
a métodos

atributos orivados

private double woltalje;
private double intensidad;
private double tiempo; 3

Linea

Instance variables

e private double voltaje = 0.0 At b t
a Ct u a I % Constructor, gl que se pas private double intensidad = 0.0  <.g—0 | rl u OS
y ! private double tiempo = 0.0

normales

\Apu.bl ic MedidaElectrica(double
= this.voltaje=voltaje; | ocal variables

r this.intensidad=intensida double _‘“’“3-‘-? =10
P u n t O S d e this.tiempo—tiempo: double intensidad = 1.0
1 double tempo = 1.0

Variables
locales

ruptura

2 ¢

Terminate

B

Step Into

4 10 @ »l
i

Thread "main" stopped at breakpoint. Halk
El

\ i

Continue
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Generacion de documentos

Para usar una clase, lo Unico que se necesita conocer de ella es la
interfaz publica:

e atributos: sus nombres vy tipos, y descripcion
e métodos: sus cabeceras y descripcion de lo que hacen

Se puede extraer esta informacion de manera automatica, por medio de
herramientas de documentacion.

Elegir en la ventana del proyecto:
*Tools => Project documentation
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Empaquetamiento del programa

Hay un formato para guardar de forma comprimida en un solo fichero
todas las clases y recursos que necesite un programa

e formato jar

Conviene para ejecutarlo que el programa haga toda la entrada/salida
con ventanas (no usar System.out.println)

Se genera desde el bluej con la opcion
eproject => create jar file

Se ejecuta:
e Linux: java -jar nombre fichero.jar

e \Windows: doble click sobre el icono del fichero
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